
SyRF is a fully integrated online platform for performing systematic reviews of preclinical 
studies and can be accessed at syrf.org.uk 

This guide has been developed to help users register and use the SyRF screening 
application for the management and performance of their systematic reviews – including the 
screening of large reference sets between multiple researchers. For more information or 
questions regarding this user guide, please contact us at syrf.info@ed.ac.uk  
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Glossary of terms 
Project  
Your systematic review and meta-analysis including the studies you are reviewing. 

A public project 
Project that can be seen by anyone with an account on SyRF. Users can request to join and 
can be assigned roles such as administration (i.e. have editing rights to the design of the 
project), screening, data annotation, or data extraction roles. 

A private project 
Project that cannot be viewed on SyRF by other users unless they have requested and have 
been granted permission to join the project. 

Protocol 
Structured description of what you set out to do in your systematic review and meta-analysis, 
we recommend that this is published or shared publicly with PROSPERO. 

Screen 
Include or exclude publications identified in your systematic search based on the 
inclusion/exclusion criteria defined in your protocol. Described in further detail in section 5. 

Annotation 
You may want to annotate studies by labelling or extracting relevant information from them. 
This stage of a project is fairly flexible and therefore you can define your own annotation 
questions for your project. Annotation questions should address all questions you want to 
ask as specified in your protocol. You can choose at which stage of the project you want to 
answer specific annotation questions. This is described in further detail in section 6. 

Data extraction 
Where you extract data from graphs or tables in the form of means/medians and 
corresponding error. 

Experiment 
Experiment refers to any grouping of cohorts where an experiment is carried out at the same 
time and any of them can be compared with each other. 

Cohort 

Refers to a group of animals - same species, strain, source, co-morbidities (if applicable) - 
which all receive the same procedure and treatments and can be compared to other cohorts. 
So an experiment may involve the following cohorts: Treatment, Sham and Control; or 
Control, Treatment 1 and Treatment 2. 

Whereby the following comparisons may be made: 
e.g. Cohort 1 = Disease Model 

                   Cohort 2 = Disease Model + Comorbidity 
            Cohort 3 = Sham or Disease Model Control 
                   Cohort 4 = Disease Model + Treatment (Low Dose) 
                   Cohort 5 = Disease Model + Treatment (High Dose) 
                   Cohort 6 = Disease Model + Treatment Control (vehicle) 

 

https://www.crd.york.ac.uk/prospero/


Section 1 Registration 
When you start a review, register as a user to access the SyRF screening and data 
extraction application. All review authors will need to register independently and can be 
added to a project by the project administrator. Registering helps us keep your data secure 
and allows the project administrator to control who has access to the project data at different 
stages of the review. Read our Data Management and Sharing Policy here. 

If you are a first time user 

Access SyRF at syrf.org.uk. 
 
Click on the ‘Launch SYRF’ button on the top left hand corner of the screen. 
 On the SyRF home page click ‘Register’. 

  
  
  

 

 

 

 

Here your options are to ‘Create a new account’ by using a generic email address or you 
can choose to ‘Register using Google’. 

 

  
  
  
  
  

 

 

 

 

 

 

You will receive an email to complete your registration. 

I don’t see an email in my inbox from SyRF   

http://syrf.org.uk/media/1015/syrfdatamanagementsharingpolicy_20-04-16.pdf
http://syrf.org.uk/


Logging in if you already have an account 

Access SyRF at syrf.org.uk. 

On the SyRF home page click ‘Sign In’. 

 

 

 

 

 

 

 

Using the details you registered with, login using a generic email address or select ‘Sign in 
with Google’ if you have registered with a Google account. 

 

 

 

 

 

 

 

Once you have logged in, you should be able to access projects by clicking on ‘Projects’. 

 

 

 

 

 

 

 

 



Section 2 Join a Project 
 

When logged in you should be able to see Projects you are a member of and also all other 
public projects, by clicking ‘Public projects’. 

To collaborate on a project, you will need to click ‘Register to join’ on the project’s 
homepage. 

The administrator of the project will then need to grant you permission to access different 
stages of the project. 

My collaborators can’t see my project 

 

Section 3 Create a New Project 
To create a new project, simply click on ‘Create Project’. 

A form will then appear, where you can enter your project details. 

 

 

 

 

 

URL link to your protocol 
we strongly encourage you 
have a published protocol 
before you start your 
systematic review. We 
recommend that you 
publish with PROSPERO  

 

Private/Non-private 
project  
if you choose to set your 
project to private here, it 
won’t be visible on the 
Projects page to any 
other users (including 
anyone you may want to 
collaborate with). 

 

Name of Your Project 
it is helpful to make this 
concise, but descriptive 
too so that it is clear to 
others 

Description of your 
project 
this is mainly for other 
users and collaborators 
and there can be as 
detailed as you would like 

 

https://www.crd.york.ac.uk/prospero/


On clicking ‘Next’ you will be asked to fill out a form where you specify the inclusion and 
exclusion criteria for your project.  

 

 

 

 

 

 

 

 

 

 

 

Click ‘Create’ to finish creating the project. 

Section 4 Project Overview 
Once you have created your project, you can keep track of your project progress through the 
Project Details Page. If you are an administrator and need to edit any details you can also do 
that here by clicking on the pencil icon in each section. 

 

 

 

 

 

 

 

 

 

 

It is important to be specific 
and detailed for these 
sections, but also to include 
the main points about what 
screeners should include and 
exclude as part of your 
project. Key points identified 
here will appear to screeners 
during the screener stage 
and therefore need to be 
concise, but informative. 

This button will 
take you to a page 
where you can 
view all the studies 
within your project. 
See the next 
section to see how 
you upload studies 

Upload 
systematic 
searches 
here 



Uploading a systematic search 

You can upload a systematic search by scrolling to the ‘Systematic Searches’ section and 
clicking the ‘+’ button. 

 

 
This will reveal the following form: 

 

 

 

 

 

 

 

 

 

 

 

Upload citation library from EndNote 

To upload your library to SyRF, you will need to export your library from EndNote in an XML 
format. 

In Endnote: Select all records (Ctril+Shift+A) 
Then go to: File>Export 
Make sure ‘Save as type’ is set to XML 
 
In SyRF when uploading your file, please select ‘EndNote XML Library File’ and choose 
the file of interest. Clicking ‘Next’ will then prompt you to check the details of the upload 
before you begin the upload. 

 

 

If you are uploading multiple 
searches (e.g. might want to 
upload an update at a later 
point) this is the information 
that studies will be tagged by 
and therefore is useful if it is 
something concise, but 
descriptive 

See below for 
use case for 
these options 

Complete 
your 
upload 



Please note, at current we support spreadsheets (i.e. csv/tsv - see below) or XML libraries 
directly exported from EndNote. So if you have your citations in another citation 
management program, you will have to transfer these to EndNote first or reformat your 
export file to look like those from EndNote or a spreadsheet with headings as shown in the 
example spreadsheet specified on our page. 

I am trying to upload an EndNote XML file that was creating by importing from a 
place other than an electronic database and getting an error 

Upload list of studies as a spreadsheet with or without screening decisions 

If you have already screened your list of studies outside of SyRF, you can still upload your 
library and bring this existing information into SyRF for further steps of your project. You can 
do this by saving your study details in a csv or tsv file and selecting the appropriate upload 
option when uploading your search. Please check here for the format your file needs to be in 
before upload. 

 

 

 

 

 

 

 

Next, if you want to add screening decisions, make sure to have “Toggle to include 
screening decisions with upload” on and fill out the appropriate information for SyRF to be 
able to attribute data correctly. 

 

 

 

 

 

 

 

Please note, if you need to delete a systematic search from your SyRF project refresh the 
browser first. 

 

 

Tell SyRF, 
which stage 
you would like 
to add your 
screening 
decisions to 

Select 
.csv or 
.tsv file to 
upload 

Tell SyRF, 
which 
investigator on 
the project you 
would like to 
attribute the 
decisions to Add multiple 

screener decisions 

Tell SyRF, what 
the name of the 
column in your 
file is that 

https://app.syrf.org.uk/assets/pdfs/Systematic%20search%20instructions.pdf


If you require full-text for your studies 

If you require full-text to be available at any stage of your project, it is important that you 
have already retrieved these before uploading your search file. In the systematic search file 
that you upload (csv/tsv spreadsheet or XML from Endnote) make sure the column “PDF 
Relative Path” contains relative path links (i.e. relative to the root of the folder you send to 
us) to your PDFs for each record.  

 

You will then need to contact us with the name of your project and share the folder 
containing your PDFs via Google Drive or similar.  

We will upload these PDFs to the SyRF database and these can be opened from the 
screening form. 

You can use EndNote to retreive PDFs accessible through your institution’s 
subscription 

In Endnote: Select all records > Right click > Select ‘Find full text’. You may need to authenticate your 
log in details for your institution. There is a limit of searching for 250 per go but it is worth going 
through this step multiple times if necessary as it is the quickest way of retreiving PDFs at present. 
Endnote will download, save and name the PDFs. These can then be found in your Endnote Data File 
in a folder named ‘PDF’. 

If you download your PDFs in this way, it is advisable to keep the PDF names and links 
specified by EndNote so that the links get matched to the appropriate record. 

I am performing a two-stage screening process and need to add PDFs only for my 
included studies for full-text screening 

  

Title Authors
Publication 

Name
Alternate 

Name
Abstract Url

Author 
Address

Year DOI Keywords
Reference 

Type
PDF Relative Path

Very interesting 
study

Author, 
A.; 

Author, 
B.

Best Journal

This is an 
abstract about 

a very 
interesting 

study.

2019
354759f.
nvuvyedi

en

Journal 
Article

/first_batch/345_2019.pdf

mailto:syrf.info@ed.ac.uk?subject=PDFs%20to%20upload


View project studies and study details 

You can now view project studies by clicking on the ‘View Project Studies’ button. This will 
show you all the studies you have uploaded to your project. 

 

 

 

 

 

 

 

 

 

 

 

  

If you have a PDF associated 
with a study, a PDF icon will 
appear for your record here 

If you have 
screening decisions 
for a study, they will 
appear here (i.e. 
Included, Excluded, 
or Insufficiently 
Screened) 

If you have 
multiple 
searches 
uploaded, this 
is where you 
can see, 
which study is 
part of each 
search 



Section 5 Define screening project stage 
 

A typical systematic review project might have the following stages: screening for inclusion, 
annotation of studies/data abstraction, reconciliation*, analysis*. 

To define the stages of your project go the Stages section of your project homepage and 
click on the ‘+’ button. 

 

 

*As SyRF is under continuous development these stages have to be performed outside of SyRF at present. We 
can try to provide some assistance for these stages, but please note you will have to perform these outside of 
SyRF. 

 

 

When adding a project stage, enter details to define the stage 
and click ‘Create’. If you would like to include screening make 
sure the ‘Include Screening in stage’ option is selected. 

 

 

 

 
 
 
 
 
Stages created appear in the ‘Stages’ section of your project. To enter one simply click ‘Enter 
Stage’. 

 
 
 

  

The ‘Include Screening in stage’ check box 
allows you to combine different stages with 
the screening process. This is useful if you 
want the option to exclude publications at any 
point in the reviewing process. E.g. Screen 
plus answer selected annotation questions. 
Always tick this box for your screening stage 



Screening 

To start reviewing enter your screening stage and press ‘Start Reviewing’. 

 

 
 

 

 

 

 

 

 

You will then be presented with the following screening form (if there are eligible studies left 
for you to screen) and be able to start screening. If you would like to include selected 
annotation questions at this screening stage then please move on to and follow the 
instructions below described in the next section about how to design and add annotation 
questions to a stage. 

 

 

 

 

This gives a quick 
summary of the stage 
you have entered into  

Inclusion/Exclusion 
criteria defined at the 
beginning of a 
project. This should 
be descriptive 
enough so that other 
screeners can 
understand exactly 
what you are trying to 
include and what you 
are trying to exclude 
from your overall 
project. This 
information can be 
edited on the project 
overview page 

If there is an 
abstract for a 
study, this will 
appear here. 
If there is a 
full-text PDF 
linked to a 
study, this will 
appear as a 
link below the 
abstract    

This bar shows your review progress.  
Green: represents studies that you have screened,  
Blue: the remaining number of studies that are available for you to screen, 
Orange: studies which are unavailable for you to screen (e.g. due to 
sufficiently being screened)   

Use these 
buttons to 
navigate and 
make 
decisions for 
inclusion on 
each study 

This bar shows your annotation progress. 
Green: studies with sessions fully completed by you, 
Blue: available for annotation to you, 
Orange: unavailable for annotation to you (e.g. due to completion by others) 



Screening decisions in SyRF explained 

SyRF will automatically take care of discrepancies for you if you have enough screeners. 
Currently most projects are set to have a minimum number of 2 screeners, with a project 
agreement ratio of 0.333 (Information specified on your project home page, under ‘Screening 
Details’). 

 

 

This means that publications are marked as ‘Included’, ‘Excluded’ or ‘Insufficiently 
screened’, whereby you need at least 2 screeners for each study to have agreed on their 
decision (both said include or exclude). A study will continuously be offered up for screening 
to other reviewers until this threshold has been met, and two reviewers have given a 
publication the same decision. If this threshold has not been met, then this will be marked as 
‘Insufficiently screened’ and offered up to the next reviewer. 

If you would like different criteria for sufficient screening, please contact us and don’t forget 
to include your project name. 

My project only has two screeners, how can I see screening decisions? 

 
  

mailto:syrf.info@ed.ac.uk?subject=Screening%20Criteria%20in%20SyRF


Section 6 Define annotation questions 
As part of the data abstraction process you can annotate studies within SyRF by specifying 
what question you want your reviewers to answer about each publication in your project.  

In order to do this go to the ‘Design Annotation Questions’ button on the project overview 
page. 

 

 

Questions may be nested to allow for hierarchy of conditional information entry (i.e. 
questions can become active, depending on answers to other questions). 

Annotation questions are entered into the following categories: 

Study 

Enter any question that is relevant to the overall study 

e.g. Do the authors refer to a protocol? 
(Yes or No checkbox) 

        

 

 

 

 

 

 

State the question you 
would like to be displayed 
to the reviewers    

If you want to make 
answering a question 
compulsory you can 
tick “required”.  

You can pre-specify here what 
format you expect the answer to 
your set question to be. SyRF will 
respect this and not let a reviewer 
submit an answer unless it 
complies with these rules   

Select the type of the control 
you want for this question   

For certain controls you will be 
able to specify what answers 
reviewers can select from. 
Using of a pre-specified list can 
reduce the likelihood of human 
error when entering data 

Clicking this symbol allows you 
to change the order of items by 
dragging them in the right place  



Disease Model Induction 

Control Question 

Define questions that are specific to the Model control 

e.g. Do the control animals receive Sham surgery?  
(Yes or No checkbox) 

Non-Control Question 

Define questions that are specific to the Model 

e.g. What type of  surgery was done to induce the model? 
(Dropdown list with defined options)  

Both 

Define questions that are relevant to both Model control and Model animals 

e.g. What anaesthetic is used for both the model and sham surgery?  
(Dropdown list with defined options) 

Treatment 

Control Question 

Define questions that are specific to the Treatment 
control 

e.g. What is the vehicle given to the control animals? 
(Dropdown list with defined options) 

Non-Control Question 

Define questions that are specific to the Treatment group 

e.g. Specify the dose of treatment drug given in mg/kg  
(Integer input field) 

Both 

Define questions that are relevant to both Treatment control and Treatment animals 

e.g. What route of drug or vehicle administration is used in the experiment?  
(Dropdown list with defined options) 

Outcome assessment 

Define questions relevant to each outcome 
assessment procedure in the study 

e.g. What is the behavioural test used to measure 
outcome?  
(Dropdown list with defined options) 



Cohort 

Define questions relevant to each cohort procedure in 
the study 

e.g. What is the sex of the animals included in the 
cohort? 
(Dropdown list with options males, females, both, unknown) 

 
I have cohorts with comorbidities and I'm not clear on how to differentiate between 
them 

 

Experiment questions 

Define questions relevant to each experimental procedure in the study 

e.g. Was there a habituation period? 
(Yes or No checkbox) 

  



Nesting Questions 

For each question you can choose to add related questions, if you want to get answers to 
additional questions, which are conditional on the answer to the previous question. 

e.g. “What is the model type?” 
(Drop down list with option of: Pharmacological or Surgical) 

If Pharmacological is selected we could add a related question by selecting “Add 
Pharmacological Related”, which you will then be able to see nested under your previous 
question. 

 

 

 

 

 

 

e.g. “What is the drug given?”  
(Drop down list with options of different drugs) 

 

 

 

 

 

 

 

 

 

You could then further subset this question, by clicking on it and selecting ‘Add Related’ and 
asking for each drug selected: “What is the dose and route of delivery?”  

If Surgical is selected then we may ask the related questions: “What was the anaesthetic 
used?” or “What was the site of lesion?” 

 

 

 



Section 7 Define annotation project stage 
Once you have designed all annotation questions, you should specify the stage at which you 
want to answer each question. You can do this before you start screening or after you have 
finished screening.  

To be able to add questions to your stage of interest go to the ‘Stages’ section of your 
project homepage and click ‘Enter Stage’. 

 

 

 

 

You will then need to click on ‘Stage Design’ to start editing the stage. 

 

 

 

 

To add questions you will need to turn on ‘Annotation’ for this stage of the project using the 
slider.  

 

 

 

 

If you want to do screening and/or data extraction at the same time, you will also need to 
have these functionalities turned on (e.g. even if you have screened at a separate stage, you 
might want to have the functionality of being able to exclude a study at a later time point 
when you have read the full-text). 

 

 

 

 

 

 

 

 



You will then be able to select the questions that you want to be included in this stage by 
checking the box next to the relevant questions. 

 

 

 

 

 

 

 

 

Next time you enter a stage from the project homepage and click 
‘Start Reviewing’. you should be able to see at the bottom of the 
page the questions you have enabled. The tabs named “Study”, 
“Disease Model induction”, “Treatment” etc. contain the different level 
annotation questions, depending on where you have included 
questions. Click on each tab to see the questions attributed to each. 

 

 

 

 

 

 

 

 

 

 

Make sure you save your progress throughout 
the annotation process using this button 

Save and mark 
a study as 
‘Complete’ 
process using 
this button 

Undo your 
changes 

Delete your annotations 
for the study 

Please note that for some levels 
questions will only show once you 
have given your entry a ‘label’ (i.e. a 
name) e.g. Cohort A or Model 1 

Also please 
remember that 
questions are 
nested under the 
section you have 
created them. So 
if you have 
created a Control 
question for a 
section, then your 
question will only 
appear if you 
have identified 
your entry as a 
Control procedure 

In this example 
we have only 
added annotation 
questions at this 
level and 
therefore no other 
levels are visible 



Section 8 Define data extraction stage 
 

If you would like to extract time-point data collected for outcomes from a publication, you 
need to have ‘Data Extraction’ enabled.  

To have this at a separate stage, you will need to create a new project stage, by clicking ‘+’ 
on the project overview page under ‘Stages’. 

 

 

 

 

 

When you enter into the stage, and press ‘Study Design’, you will need to make sure to turn 
‘Data Extraction’. Please note ‘Annotations’ being enabled is a prerequisite for enabling 
‘Data Extraction’. You may or may not want to perform these within the same stage, 
however. 

 

 

 

 

Enabling ‘Data Extraction’ will activate a set of required system annotations (which are not 
defined by the project administrator). 

You will need to pull some of the annotation information entered together to be able to start 
entering outcome information. For example, you will need to specify:  

procedures carried out on an animal, 

treatments administered (where appropriate)  

details about the outcomes that have been assessed  

 

 

 



Once you have this information you can start combining these pieces of information to create 
‘Cohort’s. 

 

 

 

 

 

 

 

 

 

 

Once this has been done reviewers will be able to extract numerical data for reported 
outcomes in a publication being reviewed.  

 

 

 

 

 

 

 

 

 

 

If ‘Annotations’ are enabled without ‘Data Extraction’ then only the annotation questions 
defined by the project administrator will be shown on the annotation form (see section 6 
above). 

Details about 
each cohort 
that you are 
extracting 
data for 
appear here  

Add the 
cohorts 
involved in an 
experiment  

Create cohorts 
by putting in the 
relevant 
information from 
each section  

Time = Time of assessment, the time zero 
should be consistent across all studies included 
in the review. For example, time zero may 
equal time of model induction or may equal 
time of drug administration. If necessary, all 
reviewers within your project should be 
informed of this 

 

Enter time 
point data for 
a specific 
outcome 



Troubleshooting & FAQ’s 
I have registered on SyRF, but I have not received my authentication email.  

We advise that you check your Spam/Junk folder as sometimes the authentication emails 
might go here. If you are still having issues then please can you email us with your name 
and the email address you are trying to register with so we can get a better idea of what the 
issue may be. 

I would like to invite collaborators to my project, however they cannot see the project I have 
created. 

Have you set your project to “Private”? A private project can only be seen by the people 
already registered to the project. In order to allow your collaborators to see and join your 
project, you will have to make your project “Public” first, and then you can make it private 
once they have joined successfully. 

I have made changes to my protocol, can I update the version you have for me on the 
website? 

While we strongly encourage you to have a protocol registered before you begin your 
review, we acknowledge that protocols can change as a project goes on and therefore yes, it 
is possible to update your published protocol and if you would like to proceed with this could 
you please send an updated version of your protocol to us, specifying at the bottom of when 
and what changes were made to the original protocol. 

I am having trouble uploading my EndNote library onto the SyRF application. 

If you are uploading a literature search without screening results, you can export your 
bibliography straight from your reference management software. Currently we only support 
libraries exported from EndNote in an XML format. We also now additionally support csv/tsv 
files where you can bring into SyRF screening decisions made outside of the app. Please 
follow the instructions specified in ‘Section 3 Create a new project’. 

I exported my EndNote file for editing in another software (eg. R Studio) before putting it 
back into EndNote and then exporting this edited version as an XML for upload into SYRF. I 
keep getting an error 

This is to do with how EndNote codes your file up when exporting to XML, and so when you 
take it out and try to put it back in again, for publications where there are multiple authors, 
these will now default to one line and thus be recognised as a single author. EndNote 
recognises text on a new line as a separate author, therefore you will need to do Edit > Find 
and Replace, select the field “Author” and replace the indicator of an ending of an author (i.e. 
“., “) with Special Insert > Carriage return to make sure each author is on a new line within a 
publication’s “Author” field. Finally, EndNote on exporting adds an “and” between the last two 
authors, so this will have to be similarly replaced using Edit > Find and Replace to make 
sure these authors are also on new lines and recognised as separate. 

I am performing a two stage screening process, whereby I want to take all the included 
studies from abstract-level screening and screen them at a full-text level. How do I add my 
full-texts in order to do this?  

Usually if you create another stage in your project, without screening just annotation, then 
SyRF should automatically present only your included studies for annotation. In order to 



perform a second stage of screening, you will need to first identify your included studies, by 
going to the ‘Project Studies’ page. Here you can set the Rows per page option to “All” and 
then download all the studies to a spreadsheet, where you can filter out the ones that are 
labelled as “Included” in the ‘Inclusion Status’ column. You will then need to obtain PDFs for 
these studies and send us them as described in the If you require full-text for your studies 
section of this document. Unfortunately there is no way to currently perform two screening 
levels within the same project, and therefore these full-texts will then be added to a new 
project in SyRF for you to screen a second time. Please get in contact with us if you would 
like to do this. 

My project only has two screeners, how do I view the discrepancies and conflicts from my 
project’s screening stage? 

As explained in the section Screening decisions in SyRF explained, screening works best for 
projects with more than 2 screeners and therefore if your project does have more than 2 
screeners, then SYRF will have automatically resolved discrepancies for you once all 
reviewers have finished screening. If you only have 2 screeners on your project, then you 
can either involve a third screener to see all the studies where your first two screeners 
disagreed, or simply click the ‘View Project Studies’ button on your project homepage to see 
a list of all your uploaded studies, and those that have “Insufficiently screened” as their 
‘Inclusion Status’ will be the ones you disagreed on. 

*If you would like to know specific screening decisions for each of your reviewers, please 
find your project on this page and paste the Link given into your browser’s URL. On this 
page you can find and download the specific data behind your project. To download 
screening decisions, the first link on the left-hand side should give you the final decisions for 
your studies and the second one should give you individual screener decisions. 

I want to make comparisons between the efficiency of different models, where all the models 
have the same main disease, but some groups are also given a co-morbidity; as well as look 
at the difference between models treated and not treated. How would I set my cohorts up in 
order to extract data for all these groups? 

You will need to enter your main disease under your ‘Disease Model’ details tab and 
describe how this model was created here. To be able to enter a comorbid animal, it’s best 
to add a tickbox at Cohort level, which says “Co-morbid animal” (Tick for Yes and Leave 
blank for No). You can then enter your cohorts as follows: 

- Cohort 1 - Naïve animals (for NMD calculations, where appropriate): This cohort will 
would no disease model and therefore this field would be left blank for this cohort. 

- Cohort 2- Sham animal (control for disease model animal): This cohort would be a 
disease model as you are performing some sort of procedure (eg. doing surgery but 
not giving lesion), and you should tick control for this as this is a control for your 
disease model induction.  

- Cohort 3 - Disease model animals: This cohort would have your disease model of 
interest only.  

- Cohort 4 - Disease model + Comorbidity animals: This cohort will have the disease 
model of interest and answers to questions that you could nest under your question 
“Co-morbid animal”-Yes. 

- Cohort 5 - Stroke + Treatment: Disease model of interest and your treatment as 
treatment 

- Cohort 6 - Stroke + Comorbidity + Treatment: This will have the disease model of 
interest and answers to questions that you could nest under your question “Co-
morbid animal”-Yes + Treatment. 

https://camarades.shinyapps.io/SyRFOutcomeLinkGen/


I have finished data extraction and would like to move on to analysing my data. 

SyRF is unable to perform analyses at this stage. The best way to start the analysis stage is 
to download your data from SyRF, by finding the link to your project here and copying and 
pasting it into your browser to see the data specific to your project and make sure it’s correct 
and there. Once you are happy with this, we have a meta-analysis app that is able to 
perform some calculations and draw some graphs for you, which you can find here. This has 
limited use as it was designed for standard meta-analyses, so does not work for all projects. 
The code behind the app can be found here. The user guide is available here. It’s important 
to make sure all the column names in your file match those specified. Please note, this app 
is still under development, and therefore it isn’t able to perform nesting just yet, so this has to 
be done outside of the app.  

 

If there are any questions you have not found an answer to here, please feel free to get in 
touch, sending us the relevant information about the project you are working and your user 
information, to help us investigate and answer your query quicker. Screenshots and detailed 
descriptions help us a lot! We also welcome feedback, so would love to hear your thoughts! 

 

 

https://camarades.shinyapps.io/SyRFOutcomeLinkGen/
https://camarades.shinyapps.io/meta-analysis-app-syrf/
https://github.com/qianyingw/meta-analysis-app-syrf

	Sections within this document
	1 Registration
	2 Join a project
	3 Create a new project
	4 Project Overview
	5 Define screening project stage
	6 Define annotation questions
	7 Define annotation project stage
	8 Define data extraction project stage

	Glossary of terms
	Project
	Protocol
	Screen
	Annotation
	Data extraction
	Experiment
	Cohort
	Section 1 Registration
	If you are a first time user
	Logging in if you already have an account

	Section 2 Join a Project
	Section 3 Create a New Project
	Section 4 Project Overview
	Uploading a systematic search
	Upload citation library from EndNote
	Upload list of studies as a spreadsheet with or without screening decisions

	If you require full-text for your studies
	View project studies and study details

	Section 5 Define screening project stage
	Screening
	Screening decisions in SyRF explained

	Section 6 Define annotation questions
	Study
	Control Question
	Non-Control Question
	Both

	Treatment
	Control Question
	Non-Control Question
	Both

	Outcome assessment
	Cohort
	Experiment questions
	Nesting Questions

	Section 7 Define annotation project stage
	Section 8 Define data extraction stage

	Troubleshooting & FAQ’s
	I have registered on SyRF, but I have not received my authentication email.
	I would like to invite collaborators to my project, however they cannot see the project I have created.
	I have made changes to my protocol, can I update the version you have for me on the website?
	I am having trouble uploading my EndNote library onto the SyRF application.
	I exported my EndNote file for editing in another software (eg. R Studio) before putting it back into EndNote and then exporting this edited version as an XML for upload into SYRF. I keep getting an error
	I am performing a two stage screening process, whereby I want to take all the included studies from abstract-level screening and screen them at a full-text level. How do I add my full-texts in order to do this?
	My project only has two screeners, how do I view the discrepancies and conflicts from my project’s screening stage?
	I want to make comparisons between the efficiency of different models, where all the models have the same main disease, but some groups are also given a co-morbidity; as well as look at the difference between models treated and not treated. How would ...
	I have finished data extraction and would like to move on to analysing my data.


